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NOTICE INVITING TENDER 

FOR SUPPLY OF 30,000MT ±10% 

IMPORTED STEAM COAL  

(SUPPLY ON FOR-PLANT DELIVERED BASIS 

OR EX-PORT RAKE LOADED BASIS) TO 

DHARIWAL INFRASTRUCTURE LIMITED 

UNIT NO: 1 

MEDIUM TERM PPA (210 MW NET CAPACITY) WITH CENTRAL RAILWAYS, MUMBAI 

 

 

E-TENDER TYPE: TRANSACTION CHARGE MODEL 

 

 

For delivery starting April 15, 2023 

 

E-Tender No. 

MLS/SRO/Operations/17/22-23/ET/29 

 Due for submission at 14.00hours (IST) 

On 

24/03/2023 

  



MSTC, SRO, Chennai  NIT for Import of Steam Coal 

Page 2 of 33 
 

Schedule of e-Tender (SOT) and e-Reverse Auction. 

 
DIL TENDER SPECIFICATION NO. 

                                  DIL/CI/23-24/01 
Supply of 30,000 MT of MINIMUM 4200 GCV (ARB) imported 
steam coal from Kakinada/ Krishnapatnam /Western ports 

 

 
MODE OF TENDER 

e-Procurement System 
(Online Part I- Techno-Commercial Bid and 
Part II - Price Bid and e-Reverse auction) through 
https://www.mstcecommerce.com/eproc 
of MSTC Ltd. 

E-Tender No             MLS/SRO/Operations/17/22-23/ET/29 

Date of NIT available to parties to 
download 

From 15/03/2023 15:00 hrs. to 24/03/2023 14:00 hrs. (IST) 

 
 

EMD/Earnest Money Deposit 
(EMD) 

 
INR 5  Lakh (Rupees Five Lakh only) on MSTC Account : 
MSTC LTD 
A/c No 200000598217 
IFSC CODE : INDB0000007 
INDUS IND BANK  
 
EMD should get credited to the account of MSTC LIMITED one 
day Prior to the closing date of submission i.e  24/03/2023  
 

Date of Pre-bid Meeting   
Online Pre-Bid Meeting will be DIL on 21/03/2023 at 11.30 AM.  
Interested bidders may write to following email prior to pre-bid 
meeting: 
jdamodaran@mstcindia.co.in/nshanmugam@mstcindia.co.in 
 

Date of Starting of e-Tender for 
submission of online Techno-
Commercial Bid and price Bid 

 
15/03/2023. from 19:00 HRS 

Date of closing of online e-Tender 
for submission of Techno-
Commercial Bid & Price Bid. 

 
24/03/2023 14.00 HRS 

Date & time of opening of Part-I 
(i.e. Techno-Commercial Bid) 

 

24/03/2023 14:30 hrs 

Date of e-Reverse Auction Date to be confirmed later for eligible bidders 

Tentatively on 28-03-2023 
Part-II Price Bid: Date of opening 
of Part II i.e. price bid After close of e-Reverse Auction  

 
 

Validity of bids 

7 days from the opening of Bid Part-I and has to be extended 
from time to time if situations warrant due to the administrative 
procedures in vogue. 

********************************** 
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Instruction to Bidders 

for submission of online Bid in e-Tender and e-Reverse Auction 

 

MSTC is only an e- platform service provider and all terms & condition of buyer as per E-tender will be applicable. 

No deviation of terms & condition will be acceptable Bidders are requested to read the terms & conditions of 

this tender before submitting their online bids. Bidders who do not comply with the conditions with documentary 

proof (wherever required) will not qualify for the e-Reverse Auction and for opening of price bid. In this document 

the terms “bidders” and “vendors” mean one and the same. 

 

1. PROCESS OF E-TENDER: 

A) Registration: The process involves vendor’s registration with MSTC e-procurement portal which is free of 

cost. Only after registration, the vendor(s) can submit his/their bids electronically. This submission of bids shall 

be done over the internet. The Vendor should possess a valid Class III signing and encryption type digital 

signature certificate. Vendors are to make their own arrangement for bidding from a computer connected with 

Internet. MSTC is not responsible for making such arrangement. (Bids will not be recorded without Digital 

Signature). 

SPECIAL NOTE: THE PRICE BID HAVE TO BE SUBMITTED ON-LINE ATwww.mstcecommerce.com/eproc 

i. Vendors are required to register themselves online with 

https://www.mstcecommerce.com/eproc/index.jsp  → Register (Filling up details and creating own 

user id and password) → Submit. Please follow the ‘Registration Guide’ available in the Registration 

link before proceeding. 

 

ii. Vendors will receive a system generated mail confirming the registration in their email which has 

been provided during filling the registration form. 

 

iii. The Vendors shall have to subscribe to the buyers and categories in order to receive system 

generated mails. In order to subscribe, a vendor has to login and click on ‘My Subscription’ followed 

by ‘Add Subscription’. On successful subscription, a system generated mail shall be forwarded to 

the vendor. Please follow the guide for ‘Subscription’ available in the Dashboard before proceeding. 

 

For specific queries/ clarifications, please contact MSTC: 

Sl.No Name Mobile Email 

1 Mr Saurabh Satyarthi 9903207001 ssatyarthi@mstcindia.co.in 

2 Mr. J.Damodaram 09841002253 rmsromstc@mstcindia.in 

3 Mrs Babitha rani 9444976359 babitha@mstcindia.co.in 

4 Mr.N Shanmugam 09176397264 nshanmugam@mstcindia.co.in 
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B)  SYSTEM REQUIREMENT: 

a) Operating System –Windows 7 and above  

b) Web Browser- Preferred ‘IE 8’ and above.  

c) Security Settings: 

I. Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., Remove the tick from the box 

mentioning “Enable Protected Mode”.  

II. Tools => Internet Options => Security =>Custom Level=> 

 a) Active X control & plug-ins: Enable all Active-X Controls   

 b) Scripting: Enable “Allow Status Bar Update Via Script” 

 c) Disable “Use Pop-up Blocker”  

 d) Java: JRE 8 Latest update  

 e) Other Settings:  

I. View => Toolbars=> “Tick” Status Bar.  

II. Tools=>Internet Options=> General=> Click on Settings under “Browsing history/Delete Browsing 

History”=> Temporary Internet Files=>Activate “Every time I Visit the Webpage”.  

f) For new Version of IE or other “Active –X Filtering” under Tools should not be ticked.  

g) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website 

https://www.mstcecommerce.com.  

 

2. The tender will be opened electronically on specified date and time as given in the NIT. 

3. All entries in the tender should be entered in online Price Bid Formats without any ambiguity. 

4. All notices and correspondence to the bidder(s) shall be sent by email only during the process, up to the 

finalization of tender by MSTC. Hence the bidders are required to ensure that their official email-ID provided 

is valid and updated at the stage of registration of vendor with MSTC (i.e. Service Provider). Bidders are also 

requested to ensure validity of their DSCs (Digital Signature Certificates). 

5. E-tender cannot be accessed after the due date and time. 

6. Bidding in e-tender: 

a. The process involves Electronic Bidding for submission of Bid. 

b. The bidder(s) can submit their Bid through internet in MSTC 
websitehttps://ww.mstcecommerce.com/eproc 

c. The NIT/ Documents shall be available for download in the event catalogue available under ‘Event 
Details’ of the Event. 

d. Please follow the guides for ‘UPLOADING ENCRYPTION PUBLIC KEY’ and ‘BIDDING’ under 
‘DOWNLOAD GUIDES’ available in the Dashboard before proceeding to submit bid. 
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e. The bidders may upload the bidding related documents in the link ‘My Documents’. The documents 

uploaded here shall be available for attaching with this event in the Bid Floor. 

 

f. In order to submit bid, a vendor has to go to ‘Events’ from the menu and select ‘Bid Floor’. The 

vendor has to select the buyer ‘MSTC Limited’ from the buyer list in order to view the live events list.  

The correct event has to be selected from the event list for participation. A vendor has to submit ‘Event-

wise bid details’ that may consist of ‘Common Terms’ and/ or ‘Document Attach’. A vendor has to save 

the Common Terms and/ or attach documents by clicking the respective buttons. Once the event 

specific bids are saved, the status is updated in ‘EVENT SPECIFIC BID STATUS’ and the ‘Item 

specific BID’ button appears on the bid floor. Thereafter vendor has to click button under ‘Technical 

Cover’ in order to save the technical bid for specific lots. Once the technical bid is saved, the ‘Price 

Cover’ button appears on the screen for respective lots. Once price bid is saved, the vendor has to 

click on ‘Final Submit’. On final submission of bid, the status of the bid submission shall display ‘Bid 

submitted’ under ‘Item specific bid status’. A vendor shall receive system generated mail.  

NOTE: - The bid cannot be revised once the Final Submit button has been clicked by the bidder. 
However, if the bidder wishes to change his bids, then he may delete the bid and re- submit the same. 

 

g. In all cases, bidder should use their own ID and Password along with Digital Signature at the time 
of submission of their bid. 

 

h. During the entire e-tender process, the bidders will remain completely anonymous to one another 
and also to everybody else. 

 

i. The e-tender floor shall remain open from the pre-announced date & time and for the duration 
mentioned above. 

 

j. All electronic bids submitted during the e-tender process shall be legally binding on the bidder. Any 
bid will be considered as the valid bid offered by that bidder and acceptance of the same by Buyer will 
form a binding contract between Buyer and the Bidder. 

 

k. It is mandatory that all the bids are submitted with digital signature certificate otherwise the same 
will not be accepted by the system. 

 

l. Buyer reserves the right to cancel or reject or accept or withdraw or extend the tender in full or part 
as the case may be without assigning any reason thereof. 

 

m. No deviation of the terms and conditions of the tender document is acceptable. Submission of bid 

in the e-tender floor by any bidder confirms his acceptance of terms & conditions for the tender. 
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n. Unit of Measure (UOM)is indicated in the e-tender Floor. Rate to be quoted should be in Indian 

Rupee as per UOM indicated in the e-tender floor/tender document. 

7. Any order resulting from this e-tender shall be governed by the terms and conditions mentioned therein. 

8. No deviation to the terms & conditions are allowed. 

9.Buyer has the right to cancel this e-tender or extend the due date of receipt of bid(s) without assigning any 

reason thereof. 

10.The online tender should be submitted strictly as per the terms and conditions and procedures laid down in 

the website https://www.mstcecommerce.com/eproc/index.jspof MSTC Ltd. 

11. The bidders should upload all the documents required (if any) as per terms of NIT. Any other document 

uploaded which is not required as per the terms of the NIT shall not be considered. 

12. The bid will be evaluated based on the filled-in Price bid formats. 

13. Canvassing in any form in connection with the Tender is strictly prohibited and the bids submitted by the 

bidders who resort to canvassing are liable to be rejected. 

 

C) BIDDING PROCESS: 

The entire bidding process is divided into two stages viz Stage I and Stage II.  

Stage I bidding will be through e-Tender and Stage II bidding will be through e-Reverse auction. 

 

D) PROCESS OF E-TENDER: 

The e-Tender shall have two covers - Techno-Commercial Bid (Part1) and Price Bid (Part 2). The bidder must 

fill up both the Part 1 and Part 2 of e-Tender before making final submission. During tender opening, the 

Techno-Commercial bids will be opened electronically on specified date and time as given in the tender 

document. 

The Techno-Commercial bids will be evaluated and the bids which are found to be in accordance with the 

tender requirement will be shortlisted as Technically Qualified Bids and the respective bidders shall be known 

as Technically Qualified Bidders. 

The Technically Qualified Bidders shall be invited to participate in the e-Reverse auction on the stipulated date 

and time. Such invitation will be sent to the registered e mail address of the Technically Qualified Bidders and 

no separate intimation shall be sent. Hence bidders are advised to provide their correct email addresses during 

registration and keep checking their mails. NON- RECEIPT OF EMAIL WILL NOT ENTITLE ANY BIDDER TO 

LODGE ANY CLAIM AND NO COMPLAINT IN THIS REGARD SHALL BE ENTERTAINED. 

 

E) OPENING OF PRICE BIDS OF E-TENDER: 

Price bids received from only Technically Qualified Bidders in e-Tender will be opened electronically after 

completion of the e-Reverse auction process. 
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Since the uploaded documents shall be downloaded for evaluation, Uploaded documents should NOT be 

protected with Password. 

The bidder should note that only a file which is “attached” with the e-Tender shall be considered during 

evaluation of the Technical Bid. Files which are not attached to the e-Tender shall not be considered for 

evaluation. Please note that bidders should upload the file and also attach to particular E-Tender. 

The Bidder should also note that a Bid will be considered as submitted if and only if the Bidder has made 

FINAL SUBMISSION. Only such Bids will be opened for which Final Submission has been made. It is further 

clarified that saving of Technical Bid and / or Price Bid without Final Submission will be treated as non-

submission of bid in e-Tender. 

Since the uploaded documents shall be downloaded for evaluation of bid, bidders are advised to upload clear 

scanned copies (*.pdf format files only). MSTC/Buyer reserves the right to call for additional copies or other 

documents for the purpose of bid evaluation, if deemed necessary. Such documents shall have to be submitted 

by the bidder within the time provided for submission. 

Upon successful submission of e-Tender (i.e. after Final Submission), the Bidder shall receive a bid 

acknowledgement mail from the system automatically in their registered email id. 

The Bidders may note that the Technical Bid and the Price Bid submitted in e-Tender will be encrypted by the 

MSTC’s own software before storage in the database. This will be done to protect the sanctity and 

confidentiality of the Bids before the actual opening of the same. 

The Bidder has an option to edit Technical Bid and Price Bid as many times as it wishes till the final submission. 

 

F) BIDDING IN E-TENDER& REVERSE AUCTION: 

a) Bidder(s) need to submit necessary EMD well in advance preferably one day prior to due date of submission, 

taking into account the transfer time of the amount from bank to the account of the MSTC. No interest will be 

paid on EMD. EMD of the unsuccessful bidder(s)will be refunded by MSTC. 

b) During bid submission process in e-Tender, the bidder should allow to run an application JAVA 

ENCRYPTION APPLET (process along with screen shot available at vendor guide) by accepting the risk and 

clicking on run. This exercise has to be done immediately before clicking on the Techno-Commercial bid. If 

this application is not run then the bidder will not be able to save/submit his bid. 

c) After filling the Techno-Commercial Bid, bidder should click ‘save’ for recording their Techno-Commercial 

bid. Once the same is done, the Price Bid link becomes active and the same has to filled up and then bidder 

should click on “save” to record their price bid. Then once both the Techno-Commercial bid & price bid has 

been saved, the bidder can click on the “Final Submission” button to register their bid. 

d)In all cases, bidder should use their own ID and Password along with Digital Signature at the time of 

submission of their bid. 

e)During the entire e-Tender and e-Reverse auction process, the bidders will remain completely anonymous 

to one another and also to everybody else.  L1 rates in E-Tender as well as E-Reverse auction will be compared 
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and lowest L1 price obtained will be forwarded for buyers’ approval. If no bid is received in E-Reverse auction 

then L1 price obtained in the E-Tender will be taken as final L1 rate. 

f) All bids (Delivered on ex-port Rake loaded basis or delivered at station basis will be considered as per 

enclosed format on landed cost basis and taken together for e-reverse auction 

The e-Reverse Auction will be done first to discover lowest price and will be compared with the lowest price of 

e-tender price bids to arrive at the least cost Bidder 

g) The e-Tender floor shall remain open from the pre-announced date & time and for as much duration as 

mentioned above. 

h) All electronic bids submitted during the e-Tender and e-Reverse auction process shall be legally binding on 

the bidder. Any bid will be considered as the valid bid offered by that bidder and acceptance of the same by 

the Buyer will form a binding contract between Buyer and the Bidder for execution of supply. 

i) It is mandatory that all the bids are submitted with digital signature certificate otherwise the same will not be 

accepted by the system. Bids with value up to two decimal points is permitted. 

j) DIL / MSTC reserves the right to cancel or reject or accept or withdraw or extend the tender in full or part as 

the case may be without assigning any reason thereof. 

k)  No deviation of the terms and conditions of the tender specification is acceptable. Submission of bid in the 

e-Tender / e-Reverse auction by any bidder also confirms his acceptance of terms & conditions for the tender. 

l)   The e-Reverse auction process shall remain open for bid submission for a pre-declared period and shall 

be subject to auto extension of bid closing time by Ten minutes from the last bid time if any bid is received in 

the last ten minutes. 

m) The prevailing / current lowest bid in INR, inclusive of GST, will be displayed on the bidding screen during 

the course of e-Reverse auction and a ll subsequent bids shall have to be quoted lower than the prevailing/ 

current lowest bid. The minimum decremental value shall be INR 20. Bidding will be in INR per MT. 

n) The server time shall be treated as final and binding. Bids recorded in the server before the bid closing time 

will only be treated as valid bid. Bidders are, therefore, advised to submit their bids well before the closing time 

of e-Tender /e-Reverse auction. If any bid reaches the server after the bid closing time as per server time, the 

same will not be recorded and no complaint in this regard shall be entertained. 

o)  Bidders are advised to exercise caution in quoting their bids in e-Tender and e-Reverse auction to avoid 

any mistake. Bids once submitted can’t be recalled. 

p)  The bids in the e-Reverse auction will be on TOTAL Landed Price basis PER MT ( INCLUSIVE OF GST+ 

GST COMPENSATION CESS), calculated on proportionate basis at 4200 GAR, as below.  

(i) Landed Price per MT, inclusive of GST and GST COMPENSATION CESS), shall be calculated as follows: 

(ii) For a bidder, offering from either Kakinada or Krishnapatnam or Western ports on single port basis, landed 

price shall be obtained by adding the corresponding railway freight from the port to destination  
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e.g. Bidder offering from Kakinada only 

Bidder’s ex-Kakinada rake loaded basis Price inclusive of GST & GST COMPENSATION CESS) = Rs 

6000/MT 

 Railway freight from Kakinada to DIL Plant inclusive of GST = Rs 1507.40/MT 

Landed Price = 6000 + 1507.40 = Rs 7507.40 

All the prices here are indicative and for evaluation purpose only as giving precise values on the basis of 

manner of charging by Indian Railways based on carrying capacity, application of surcharges or change in 

rates of taxes for actual transportation charges at material point of time has no bearing on this.  

 

 

q) For those bids that are of a Calorific Value higher than 4200 Kcal/kg, the Landed Price calculated above 
shall be proportionately adjusted to 4200 GAR as per the following formula and to be recorded in the e-reverse 
auction: 

Landed Price at 4200 GAR = (Landed Price for actual GAR offered calculated as per 7 p) above x 4200)/Actual 
GAR offered 

Else, for bidders who have bid, basis 4200 Kcal/Kg GAR, Landed cost as calculated as per 7 p) i) & ii) shall 
be recorded in the e-reverse auction 

 

r) The details of the price break up of the successful L1 bidder needs to given by e-mail in specified format 
(Schedule D) to jdamodaran@mstcindia.co.in/ nshanmugam@mstcindia.co.in/babitha@mstcindia.co.in within 
30 minutes after the close of the e-Reverse auction.  The breakup should tally with the rate submitted online 
in the reverse auction. 

s) Any order resulting from this bidding process shall be governed by the terms and conditions mentioned in 
the NIT. 

t) No deviation to the technical and commercial terms & conditions is allowed. 

 

 

G) CERTIFICATE REGARDING NO DEVIATION: 

No deviation, whatsoever, is permitted by DIL, to the provisions of the Bidding Documents. The bidders are 
advised that while making their Bid and quoting prices, all conditions may appropriately be taken into 
consideration. 

The bidder is required to furnish a self-certification as per SCHEDULE-B, indicating their compliance to the 
bid documents provisions and uploaded. 

Further, any deviations, if any found elsewhere in the Bid, that pertaining to any rebates /discounts offered 
shall not be given effect to. 

------------------------- 
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Check List for documents to be uploaded during submission of bids in e-Tender (wherever applicable). 
The documents should be signed and stamped properly scanned, uploaded and attached with the e-
Tender. 

 

Sl. 
No. 

Document Required 

1. The bidder should have experience in supplying at least 4 lakh MT of Imported Non-Coking Coal in 
each any of the two years during the last four FY (2019-20,2020-2021,2021-2022, 2022-23) to any 
Industrial Units in India directly or through PSU.  In support of the above, the Bidder must enclose 
Performance Certificate/ Invoice copy/copies to End User. 

2. GST Registration Certificates and PAN CARD copy for Indian bidders. 

3. Scan copy of the RTGS/NEFT/e-Remittance copies in proof of remittance of Earnest Money Deposit 
showing the name of the Vendor, Amount, UTR No./Money Transfer No. with date and time. 

4. Compliance certificate as per the tender SCHEDULE A. 

5. SCHEDULE B - No Deviation for all the terms & conditions of the Tender Specification. 

6. Signed copy of tender document. 

7. Bidder to submit COA of the grade of coal to be supplied SCHEDULE C 

---------------------------- 
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TERMS & CONDITIONS 

E-TENDER NO: MLS/SRO/Operations/17/22-23/ET/29 

 

INTRODUCTION: 

We, DHARIWAL INFRASTRUCTURE LIMITED (“DIL”) wish to procure 30,000 MT ± 10% of Imported Steam 

(non-coking, thermal) coal generally of Indonesian/South African/Australian/Any Other origin on FOR-Plant 

delivered basis or Ex-Port Rake Loaded basis, at the earliest, for our 2x300 MW Plant at C-6, Tadali Growth 

Centre, MIDC, District: Chandrapur, Maharashtra. (“Plant”, having siding Code: MDIT). 

The above coal is required for Dhariwal Infrastructure Limited, Unit no: 1 for Medium Term PPA (210 MW Net 

Capacity) with Central Railways, Mumbai. 

In this context, offers are being invited for supply of the same on the basis of General Terms, Conditions and 

Related Information provided in this document. 

 

A. GENERAL CONDITIONS FOR SUBMISSION OF BIDS: 

General Conditions mentioned hereunder are mandatory& must be complied with, to avoid rejection of the 

offer/s. 

1. E-TENDER to be submitted on or prior to the due date. 

2. Bidders may submit any number of offers for the coal as specified under Section C-1(a) below. 

3. Offer must be submitted online in accordance with the “2-Part Bid submission format” (Technical and 

commercial) as explained in Instruction to bidders. 

4. Each of the two parts (Part-I - “Pre-Qualification Bid Quality Parameters etc” and Part-II - Price Offer”) 

shall be submitted online (Note: In the event of non-acceptance of certain Terms in Part-I, the Bid may 

be rejected and Part-II may not be opened). 

5. EARNEST MONEY DEPOSIT(EMD): Rs 5,00,000/- (Rupees Five Lakh only) should be deposited on 

or before one day prior to last date of Bid submission in MSTC account. 

MSTC Account details: 
MSTC LTD 
A/c No: 200000598217 
IFSC CODE: INDB0000007 
INDUS IND BANK  

The EMD shall be submitted without any precondition to MSTC. 

The EMD furnished will be forfeited if 

i) The bidder withdraws his tender at any stage before the expiry of the bid validity or backs 
out after acceptance. 

ii) The bidder violates any of the conditions of the tender specification. 
iii) The bidder revises any of the terms quoted during the validity period. 

iv) The BQR evidences are found to be fraudulent or non-genuine the tenderer will be 
blacklisted for future tenders. 
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v) The bidder furnishes bogus or false particulars / information in the documents produced 
along with the offer. 

vi) If the successful Bidder fails to acknowledge the Letter of Intent (LoI)/DRAFT P.O. within 
one (1) working day from the date of letter of Intent (LoI)/DRAFT P.O. then the EMD will 
be forfeited. 

 

The EMD of all the bidders except that of the successful bidder will be returned by MSTC after the 
acceptance of Award of the Contract to the successful Bidder.  

Bid not accompanied with EMD in accordance with the above conditions will be summarily rejected by 
MSTC 

NO INTEREST WILL BE PAYABLE BY MSTC ON THE ABOVE EMD. 

 

6. Only uploaded and attached documents will be considered for evaluation purpose.  No other form of 
submission of documents will be considered for evaluation.  However, the Buyer/ MSTC reserve the 
rights to demand any documents by mail for clarification/ evaluation purpose after the tender closing 
time. 
 

7. Validity of Bids: 7 days from the opening of Bid Part-I and may be extended from time to time, if 
situations warrants due to the administrative procedures in vogue. 

 

8. Last Date of online E-Tender Submission: 14.00 hours of 24/03/2023 
 

9. Contact person of DIL   :  Mr. Anindya Dhar 

Mob: 9903010747 

Email id: anindya.dhar@rpsg.in 

 

10. Schedule for receipt and opening of bids: 

Sl.No. Description Date 

A. 

Date & Time of Commencement of Download of Tender 

Specification 
 

From 15.00 hours of 
15/03/2023 

B. 

Date and Time of Closing of Download of Tender 
Specification 
 

14:00 hours OF 24/03/2023 

C. 

Due Date and Time for Submission of Techno-
Commercial bid and Price bid for the even in the e-
procurement platform of MSTC at 
https://www.mstcecommerce.com/eproc 
 

14:00 hours on OF 
24/03/2023  

 

 

 

B. MINIMUM QUALIFICATION CRITERIA: 
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i) The bidder should have experience in supplying at least 4 lakhs MT of Imported Non-Coking Coal in 

each any of the two years during the last four FY (2019-20,2020-2021,2021-2022, 2022-23) to any 

Industrial Units in India directly or through PSU.  In support of the above, the Bidder must enclose 

Performance Certificate or copies of BLs or Invoices evidencing the above quantity. 

 
ii)  The Bidder shall have pre-qualification requirement in his/its name. Consortiums are not permitted. 

 

However,  

a) DIL reserves the right to verify all or any of the above. Bidders have to extend full co-operation for this. 

 

b) Subject to DIL being satisfied about the bidder’s capability to execute the supply in totality, the above 

conditions may be relaxed at DIL’s discretion. 

 

C. COAL SPECIFICATION & REJECTION: 
 
1. SPECIFICATION: 
 

DIL, at its discretion, intends to purchase any of the following type of Imported thermal coal of the 
desired general specification (ASTM Basis), as given below:  
a) Indonesian Origin/ South African/ Australian non-coking coal 

 
 

b) Coal of any Other Origins, subject to technical acceptance  
 

Parameters Indonesian Origin South African/ 
Australian Origin 

GCV (ARB) Kcal/Kg (Guaranteed) 4200 + 5000 + 

TM% (ARB) (Guaranteed) ≤35% (for 4200 GAR) 
≤25% (for 5000 GAR) 

≤14% 

ASH % (ADB) (Guaranteed)  ≤10%(for 4200 GAR) 
≤15%(for 5000 GAR) 

≤32% 

VM % (ADB) 39% ~ 45% 22% ~ 27% 

HGI 45 – 60 45 – 60 

Sulphur (ADB) (Guaranteed)  ≤ 0.6% (for 4200 
GAR) 

≤ 0.9% (for 5000 GAR) 

≤ 1.0% 

Ash Fusion Temp – IDT  > 1150° C > 1150° C 

Size and Fines  Size up to 50 mm 
 
 However, size of coal less 
than 2.36 mm shall not be 
more than 10% of the 
quantity received at power 
plant 

Size up to 50 mm 
 

 However, size of coal 
less than 2.36 mm shall 
not be more than 10% 
of the quantity received 

at power plant 
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Note: Offers for grades other than Indonesian, South African or Australian origins shall be subject 
to technical acceptance. Detail specifications, analysis reports to be submitted for approval. 

 
2. OTHER DETAILS: 
 
For the purpose of evaluation, the following may be considered: 

a. Delivery from Port: Ex-port Rake Loaded Basis: Kakinada/Krishnapatnam/Western Ports or

 FOR- Landed at DIL Plant Basis: Kakinada/Krishnapatnam/Western Ports only 

 

b. Delivery Schedule: Rake arrival (BoxN) at Plant to start from April 15, 2023 in a uniformly 

distributed manner. 

c. Rules & Regulations: For supplies on Ex-Port Rake Loaded Basis or FOR- Landed at DIL Plant 

basis, Bidders must also familiarize themselves with rules & regulations applicable for the railway 

rake deliveries, railway logistics plans, routes, loading rules etc. for ensuring delivery to DIL Plant 

without any hindrance or delay and Bidders shall be responsible for effecting deliveries within the 

scheduled delivery period.    

 

3. Source of Supply: 

 

a. Source Mines must be acceptable to DIL. Accordingly, DIL may request further information 

pertaining to quality of product, mine operations etc. of any of the source mines offered and 

subsequently, shall reserve the right to accept or reject such mine/s. 

 

b. With regards to clause 3.a above, it may be noted, following Indonesian Mines and/or Mine 

Locations are not acceptable to us: 

 

• Mines located in North Barito region 

• Mines located in West Kalimantan 

• PT ManambangMuaraEnim 

• PT SumberRejeckiEconomi 

• PT Jhonlin 

 

c. Supplier may indicate up to a maximum of 3 Alternate Source Mines per grade-wise (if applicable) 

bid for our acceptance. However, offers for supply of coal from multiple sources & blended on 

mother vessel shall be rejected. 

d. Supplier shall source coal from mines of repute and sold by companies that have the necessary 

legal permissions and certificates to carry out coal trading business in the respective country. 

e. For ex-port supply, Bidder to submit load port COA of the grade of coal. 

f. For ex-stock cargo at Discharge Port, Bidder to submit copies of Load port & Discharge Port COA 

along with offer for evaluation.  



MSTC, SRO, Chennai  NIT for Import of Steam Coal 

Page 15 of 33 
 

D) SCOPE OF WORK: 

Supply of 30,000 MT +/- 10% of Imported steam Coal for 4200 GAR coal. DIL reserves the right to place order 

for a lower quantity in case the coal GCV offered is substantially higher. The shipment shall reach Discharge 

Port and cargo cleared in all respect, for dispatch by Railway wagons (BoxN), to reach DIL Plant within the 

stipulated time. 

 

For supply on ex-Port rake loaded basis or for supply on FOR-DIL Plant delivered basis, Vendor shall be 

responsible for indenting, timely placement and dispatch of BoxN railway rakes to DIL, such that desired 

delivery schedule is maintained. 

 

Railway Freight from Port to DIL railway siding shall be paid by us to the Railways directly on e-mode. Vendor 

shall provide written communication to us before indenting so that necessary arrangements can be made in 

advance at our end for payment of Railway Freight. Vendor shall also intimate us through emails about the 

date and time of placement of railway rakes for loading.  

 

Vendor shall facilitate the process with the concerned Railway authorities for receiving email containing the 

‘payment link’, once the rake is loaded and RR is raised for e-payment of freight. 

 

Any & all other related services, unless specifically excluded& mentioned and which may require to be carried 

out for successful performance, shall be deemed to be Vendor’s responsibility. 

 

E) COMMERCIAL CONDITIONS: 

 

1. Quantity of Coal: 

a) The quantity of Coal to be sold and purchased under this enquiry shall be as follows: 

i) For delivery on FOR Plant delivered basis: 

(a) The quantity of Coal shall be determined on the basis of weighment at Plant’s Static/In-

motion weighbridge. 

(b) For BoxN rakes, Net weight received at Plant shall be arrived by deducting gross 

weighment of the wagons carried out at Plant Static weighbridge with Tare Weight of the 

wagon measured by Plant’s Static weighbridge.  

(c) In case the weighbridge at Plant is non-functional, the ‘Actual Weight’ mentioned in 

Railway Receipt (RR) shall be taken for those un-weighed wagons as receipt quantity. In 

case rakes are un-weighed at both ends, average weight of other weighed rakes supplied 

till date shall be taken as receipt quantity. 

ii) For delivery on ex-Port rake loaded basis: 
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(a) The quantity of Coal shall be determined on the basis of weighment at Port’s Static/In-

motion weigh bridge, where Railway Receipt (RR) Actual weight shall be taken. 

(b) In case wagons are un-weighed at Port end, then the quantity of Coal shall be determined 

on the basis of weighment at Plant’s Static/ In-motion weighbridge. 

(c) For BoxN rakes, Net weight received at Plant shall be arrived by deducting gross 

weighment of the wagons carried out at Plant Static weighbridge with Tare Weight of the 

wagon measured by Plant’s Static weighbridge.  

. 

(d) In case rakes are un-weighed at both ends, average weight of other weighed rakes 

supplied till date on wagon-wise basis shall be taken as receipt quantity. 

iii) DIL reserves the right to place order for a lower quantity of coal if offered GCV (as received) is 

substantially higher than 4200 Kcal/kg. 

 

2. QUALITY ANALYSIS: 

a. A mutually acceptable independent inspection agency (IIA), M/s Inspectorate Griffith India Pvt Ltd 

(IGI)or M/s SGS India Private Limited (SGS) shall be appointed by DIL for carrying out rake-wise 

sampling & analysis as per ASTM standard. 

b. Sampling shall be done at DIL Plant end from each rake for FOR-Plant Landed basis and at Port end 

from wagons for ex-Port rake loaded basis. 

c. Samples collected by IIA shall be divided into three parts. One lot for Analysis, One lot to be handed 

over to us and another to be kept as Referee Sample which shall be referred in the event of any quality 

related dispute between parties except for TM. 

d. Analysis shall be done at IIA’s NABL accredited laboratory. 

e. Subject to mutual agreement, the sample held as Referee Sample by IIA, shall be used for further 

testing of all or selected parameters, as in f), but excluding TM, by a mutually agreed NABL accredited 

laboratory of an Independent Inspecting Authority in case either you or us, raise any dispute on any 

specific parameter. The cost of such re-analysis shall be borne by the party who raises such dispute. 

The exact terms including procedural deviations if any, shall be recorded between the parties prior to 

commencement of re-analysis. 

f. The rake wise analysis to be carried out shall be for Gross Calorific Value (ADB), Total Moisture (TM), 

Inherent Moisture (ADB), Ash (ADB), Volatile Matter (ADB) and Size (in percentages of -2.36mm, 

+2.36 to -10mm, +10mm to -50mm, >50mm). Analysis for HGI, Sulphur (ADB) and Ash Fusion Initial 

Deformation Temperature shall be carried out on the first rake and then on the composite sample. 

Ultimate analysis shall also be carried out on the final composite sample. 

g. The analysis report shall be shared by IIA within ten (10) working days of the sample collection date. 

h. DIL may at their discretion & cost, can appoint an Inspection agent at Discharge Port prior to rake 

dispatches. Seller shall cooperate with them in this regard. 
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3. GUARANTEES & PENALTIES: 

A. Penalties on Guaranteed Parameters shall be applicable on the basis of Third-Party Analysis by the 

Independent Inspecting Agency (IGI or SGS) at Discharge Port (for ex-Port Rake Loaded basis) or at 

DIL Plant (for FOR-Plant delivered Basis supplies), to be appointed by us, as applicable. 

 

B. Penalties shall be applicable on the following guaranteed quality parameter (As determined by IIA 

(IGI/SGS): 

i. In the event that Weighted average gross calorific value on ‘as received basis’(GAR) disclosed on 

the Certificate of Sampling and Analysis at Port/Plant for the total coal delivered is below 

Guaranteed GAR up to minus 300 Kcal/Kg, then a penalty adjustment shall be made to the price 

per Metric Ton in accordance with the following formula: 

Adjusted Basic rate = PO Basic Rate x (Wtd average GAR of Delivered Coal as certified 

by IIA) /Guaranteed GAR) 

 

Where PO Basic Rate = Basic Rate Ex-port rake loaded basis/Basic Rate FOR Plant delivered 

basis 

Note: GST and CESS shall be applicable on the above adjusted basic rate. 

ii. In the event that Weighted average gross calorific value on ‘as received basis’ (GAR) disclosed 

on the Certificate of Sampling and Analysis at Port/Plant for the total coal delivered is below minus 

300 Kcal/Kg of Guaranteed GAR, then the supplied coal quantity may be rejected or DIL reserves 

the right to accept it with a penalty/adjustment made to the price per Metric Ton, for the entire 

quantity delivered, in accordance with the following formula: 

Adjusted Basic rate = PO Basic Rate - 2 x PO Basic Rate [1 - (Wtd average GAR of 

Delivered Coal as certified by IIA) /Guaranteed GAR)] 

 

Where PO Basic Rate = Basic Rate Ex-port rake loaded basis/Basic Rate FOR Plant delivered 

basis 

Note: GST and CESS shall be applicable on the above adjusted basic rate. 

 

ii. For correction of quantity due to Total Moisture, the results as certified by IIA shall be final. 

Corrections will be done as follows: 

i) For Total Moisture {As Received Basis (ARB)} 2% more than Guaranteed TM 

Weight of Coal to be reduced as Ax0.13x(B-(Cx(100-B)/(100-C))) /100 

 

ii) For Total Moisture {As Received Basis (ARB)} TM > 2 % more than Guaranteed TM, the 

coal quantity supplied shall be rejected or DIL reserves the right to accept it with imposition of 

double penalty as below  
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Double penalty shall be calculated as follows: Weight of Coal to be reduced (For B>2% more 

than Guaranteed TM) =2xAx0.13x(B-(Cx(100-B)/(100-C))) /100 

 

(Where A is Coal received weight, B is percentage value of Total Moisture of coal received, C 

is the base parameter value of Total Moisture) 

 

No correction shall be applied in case of decrease in Total Moisture below the base parameter 

value. 

 

iii. For penalty on Sulphur, the results as certified by IIA shall be final.  

 

i) For Sulphur {Air Dried Basis (ADB)} more than Guaranteed value and ≤1.00, 

a penalty at the rate of Rs.200 per Metric Tonne for every increase of 0.1% in Sulphur or part 

thereof shall be levied. 

 

ii) For Sulphur {Air Dried Basis (ADB)} >1.00, the coal quantity supplied shall be rejected or DIL 

reserves the right to accept it with imposition of double penalty as below  

 

The double penalty shall be calculated at the rate of 2 x Rs. 200/- per Metric Tonne (i.e. Rs. 400/- 

per Metric Tonne) for every increase of 0.1% in Sulphur 

 

Sulphur content below the base parameter value of Sulphur shall be ignored. 

Note: Please do not mention a “Range” for above quality parameter.  

 

iv. For penalty on Ash, the results as certified by IIA shall be final.  

 

Corrections will be done as follows: 
 
i) For ASH {Air Dried Basis (ADB)} up to 3% more than Guaranteed Ash 
Weight of Coal to be reduced as Ax1.05x(B-(Cx(100-B)/(100- 
C)))/100 
 

iv) For ASH {Air Dried Basis (ADB)} > 3% more than Guaranteed Ash, the coal quantity supplied 
shall be rejected or DIL reserves the right to accept it with imposition of double penalty as below: 
 
Weight of Coal to be reduced as 2xAx1.05x(B-(Cx(100-B)/(100-C)))/100 
(Where A is Coal received weight, B is percentage value of Ash in coal 
received, C is the base parameter value of Ash) 
No correction shall be applied in case of decrease in ash content below the Typical value. 
 

v. For penalty on Size, the results as certified by IIA shall be final.  

 
If the size as declared by IIA in air-dried sample for ≤ - 2.36 mm size particles exceeds 10% of the 
sample coal by weight received at power station, then the weight of coal shall be reduced as per 
following formula: 
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Weight of Coal to be reduced = (A*B/100)*0.1  
 
(Where A is quantity of coal received at power station, B is increase of the fines particles above 
10% in percentage value)  
 
(Example- If fines particles is 15%, then B = (15-10) = 5) 
 

a) No Premium/Bonus shall be payable for supply with “Better than Guaranteed” specification. 

 

b) For final settlement purpose, all quality parameters shall be assessed on the basis of weighted 

average values, as declared by IIA, in the final weighted average report from rake wise analysis reports 

for the purpose of price/weight adjustments. 

 
c) In case the Calorific Value result of any rake slips below the guaranteed value of 4200 Kcal/kg, but 

remains above minus 300 Kcal/kg below Guaranteed GAR, the invoicing rate for such rake should be 

proportionately adjusted down. 

 
 

d) Quality Analysis Reports at Discharge Ports shall include (i) Ultimate Analysis; (ii) Proximate Analysis; 

(iii) Sieve Analysis and (iv) AFT.  

 

e) For delivery on ex-port rake loaded basis delivery, while loading of rakes, care shall be taken by Buyer 

to keep the weighment within the railway norms. Gross under loading/overloading shall be avoided at 

all times. An under-loading tolerance of 3 MT per wagon and no overloading tolerance shall be 

permitted. U/L beyond 3 MT and O/L charges, as charged by the Railways, shall be to your account 

and shall be adjusted while making the 10% payment. 

 

 
4.  LIQUIDATED DAMAGES: 
 

For supply on ex-port rake loaded basis or on landed basis, in the event rake arrivals at plant is delayed by 
more than 7 days from the delivery date of April 15, 2023, Liquidated Damages shall apply @ 0.5 % of the 
basic price per day for the said rake subject to a maximum of 5%. In the event rake arrivals are delayed by 
more than 15 days, DIL at their discretion may cancel the contract and/or arrange for alternate supplies as 
per Risk Purchase Clause terms applicable. 

 

5. PRICE QUOTE: 

 

(i)  Ex-Port rake loaded basis  

a) Total Price in INR per MT. 

Offered price shall be inclusive of all costs, taxes, duties, GST Compensation Cess, customs duties, port 

charges, crane charges, clearing & forwarding charges, stevedoring, handling charges, plot rents, vessel 

related costs, demurrage costs, insurance charges and all other associated charges viz. cost of protection, 

preservation of cargo, dock & harbor dues and other incidental/necessary expenses which are customarily 

payable or required to be incurred till loading on to railway rakes. Railway Freight shall be borne by DIL. 
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b) GST Rate as  applicable(At present for coal: 5%) &GST COMPENSATION CESS AS APPLICABLE (At 

present Rs 400/MT) shall be considered while computing the Total Price as above. 

 

(ii)   FOR -Landed at Plant Basis 

a) Landed Price in INR per MT delivered at DIL Plant, Chandrapur.  

Offered price shall be inclusive of all costs, taxes, duties, GST Compensation Cess, customs duties, port 

charges, crane charges, clearing & forwarding charges, stevedoring, handling charges, rents, vessel related 

costs, demurrage costs, insurance charges and all other associated charges viz. cost of protection, 

preservation of cargo, , dock & harbor dues and other incidental/necessary expenses which are customarily 

payable or required to be incurred till delivery at DIL Plant including Rail Freight but excluding  GST which 

shall be payable extra. 

 

b) GST Rate as  applicable (At present for coal: 5%) & GST COMPENSATION CESS AS APPLICABLE 

(At present Rs 400/MT)shall be considered while computing the Total Price as above. 

 

Note: No other charges other than above mentioned Price & GST, shall be payable. 

 

6. PAYMENT TERMS & SUPPLY BASIS: 

 

Payments shall be made in INR, on 90/10 basis, through a Sight Letter of Credit (LC) opened in favour of Vendor 

for supply of the aforesaid coal cargo. Such LC shall be opened on a scheduled bank in India and shall be freely 

negotiable at Vendor’s nominated bank. Confirmation, if any, will be at the cost and request of the beneficiary 

 

We shall establish the said LC, which shall be sufficient to cover the minimum deliverable quantity of the coal 

cargo under our purchase order, i.e. 50,000 MT value of the cargo, subject to receipt of an acknowledged copy 

of the Purchase Order along with a LC draft.  

 

The total 90% LC value payment shall be restricted to the amount of 50,000 MT multiplied by the cost of cargo, 

with penalty adjustments, basis Disport Composite Quality results from an Independent IIA.. 

 

The LC shall be in a form consistent with standard banking practice. The LC shall provide for presentation of 

documents, as per Clause below, at the counter of negotiating bank for negotiation. 

 

A. The following documents are required for the Letter of Credit negotiation for the invoice value: 

a) Payment of 90% Invoice:  

i. One original and two copies of your commercial invoices, with adjustments certified by our 

authorized representative 

ii. The invoicing rate for a particular rake should be proportionately adjusted down as per the 

deviation in guaranteed values as per Certificate of Sampling & Analysis issued by IIA for 

that rake 
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iii. Copy of RR evidencing Actual Weight. In case of non-weighment at Port weighbridge, copy 

of Weighment Certificate from DIL Plant. 

iv. Copy of Certificate of Sampling & Analysis issued by IIA for that particular rake  

v. Copies of import documents evidencing ownership: BL, COO, Bill of Entry (price values may 

be blanked off) for the cargo supplied. 

 

b) Payment of 10% Invoice: 

i. One original and two copies of your commercial invoices with price adjustments, basis 

Purchase Order terms on Quality, Quantity and rake underloading/overloading, if any, and 

certified by our authorized representative. 

ii. Copy of RR evidencing Actual Weight. In case of non-weighment at Port weighbridge, copy 

of Weighment Certificate from DIL Plant. 

iii. Copy of Weighted average Certificate of Sampling & Analysis issued by IIA for the entire 

quantity delivered as per PO terms. 

 

F) EVALUATION BASIS: 

 

Accepted Offers shall be evaluated on the following basis – 

1. Total landed cost for per MT: 

a) FOR EX-PORT RAKE LOADED BASIS 

Landed cost: Basic Price ex-port rake loaded basis (Rs/MT)+ GST(5%)+ GST COMPENSATION 

CESS( RS 400/MT)+Rail freight charges with applicable GST 

b) FOR-PLANT DELIVERED BASIS 

Landed cost: Basic Price inclusive of Freight (Rs/MT)+ GST(5%)+ GST COMPENSATION CESS( 

RS 400/MT) 

 

2.Low landed cost on 4200 GAR basis as delivered to our Power Station (all inclusive) 

3. Specification & technical suitability 

4. The railway freight charges, including GST are as follows 

  Kakinada (KSLK) to DIL(MDIT) : Rs 1507.40 

  Krishnapatnam (KAPT) to DIL(MDIT): Rs 1614.80 

   

 If the Bidder wishes to supply from any Western Port, then they should contact MSTC with the name 

of the port they want to supply from, for ascertaining the railway freight to be considered for participation in the 

reverse auction. 

5. Reverse Auction shall be conducted for the landed cost Per MT as delivered to  Power Station (all 

inclusive) and GAR calculated on proportionate basis at 4200 GAR. Bidders offering on Ex-Port Rake 

Loaded basis should include Railway freight charges as mentioned on Sl.No 4 depending on the port 

while submitting their bids in reverse auction for sake of online comparison with For Plant delivered 

basis. Please note that for Ex.port rake basis, Railway freight charges will be paid by DIL. 
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G) SPECIAL CONDITIONS: 

 

Notwithstanding anything mentioned herein above, DIL reserve the right to – 

1. Decide on the quality of coal to be imported. 

2.Cancel/withdraw/modify this Invitation for Bid, partially or fully, without assigning any reason and shall 

bear no liability whatsoever consequent upon such a decision. 

3. Purchase Order placed on successful Bidder shall be in accordance with our standard terms & 

conditions. Your participation in the Tender shall mean your acceptance of our standard terms 

&conditions. 

4.As Proof of Ownership, seller shall submit copies of the following documents of the Coal to be supplied 

to Buyer under the terms of the PO:  

Bill of Lading (with endorsements, if any), 

Certificate of Origin, 

Loadport Certificate of Sampling & Analysis, 

Copy of Customs cleared Bill of Entry 

 

H) INDEMNITY: 

The Supplier assumes responsibility for and shall indemnify and save  harmless DIL, from all liability, claims, 

costs, expenses, taxes and assessments including penalties, punitive damages, attorney's fees and court cost 

which are, or may be required with respect to any breach of the Supplier’s obligations under the Contract, or in 

respect of all salaries, wages or statutory dues or any other compensation or dues of whatsoever, nature of all 

persons employed by the Supplier in connection with performance of the Scope of this Contract. Supplier to 

take sole control of the defense of such claims. The Supplier shall execute and deliver such other further 

instruments as may be necessary to comply with all the requirements of such laws and regulations as may be 

necessary there under to confirm and effectuate the Contract and to fully protect and indemnify DIL. DIL shall 

not in any way be responsible for any accident or damages incurred or claims arising there from during discharge 

of the obligations by Supplier under this Contract. 

 

I) SETTLEMENT OF DISPUTES: 

 

A. Disputes, Differences, Questions on issues other than Quality Related: 

 

i. If at any time, any questions, disputes or differences other than relating to quality of coal, arise 

between the parties, in connection with or related to this Purchase Order, both parties at first 

instance shall attempt to resolve the dispute through dialogue and/or written correspondence. The 

mutually agreeable decision through such process shall be minuted& signed by authorized 

representatives of both the parties and shall be given effect to. 

 

ii. If at any time, any questions, disputes or differences other than relating to quality of coal, arise 



MSTC, SRO, Chennai  NIT for Import of Steam Coal 

Page 23 of 33 
 

between the parties in connection with or related to this Purchase Order, which could not be 

resolved through the process of Dispute Redressal above, either party shall, as soon as reasonably 

practicable, give to the other party notice in writing of the existence of such question, dispute, or 

difference specifying its nature and the points at issue, and the same shall be referred to arbitration 

in accordance with the provisions of the Arbitration & Conciliation Act, 1996 by Sole Arbitrator, 

appointed mutually by DIL and you. The award shall be speaking award accepting or rejecting full 

or in part, the claims and counter claims of the party’s item-wise with reasons. The language of 

arbitration shall be English and venue shall be at Kolkata, West Bengal, India. 

 

B. If at any time, any questions, disputes or differences about quality of coal (Quality Dispute) arise 

between the parties that relate to the quality of coal, as applicable the referee sample DIL by the 

Independent Inspecting Authority, will be used to re-analyse and determine the quality of coal through 

a mutually agreeable & reputed test laboratory/company.  

 

J) RISK PURCHASE: 

 

In the event of Seller’s failure to execute the order as per the delivery schedule and other terms and conditions 

stated in the Purchase Order including amendments if any (together the “PO”), Buyer, with prior written 

intimation to Seller, shall reserve the right to purchase the material of similar grade & quality from other source(s) 

at Seller’s cost and risk, either in whole or in part, which Seller failed to deliver. In such case, Buyer shall cancel 

or short close the Order placed on Seller in full or in part and raise a debit note on Seller for the differential cost 

between the alternative arrangements and Seller’s Order value (on quantity & delivered energy cost adjusted 

basis), including all incidental charges, However, claim for all such incidental charges shall be subject to both 

Parties agreeing. In case the procurement cost through alternative source(s) becomes lower, no benefit on this 

account shall be passed on to Seller. 

 

Notwithstanding the actions as stated above, Buyer reserves the right to terminate business dealings with Seller 

in future. 

 

K) TERMINATION: 

DIL on its discretion, reserves the right to terminate the Contract either in part or in full. DIL shall in such an 

event give one week notice in writing to the Supplier of his decision to do so. 

 

L) FORCE MAJEURE: 

Neither party shall be liable to the other party for any failure or delay in making, receiving and accepting the 

supply of coal hereunder or otherwise performing the terms and provisions or conditions of this Purchase Order 

to the extent that such performance is prevented by any of the events of “Force Majeure” including but not 

limited to the following: 

i) War, hostilities, acts of the public enemy or belligerents, sabotage, blockade, revolution, insurrection 

or riot; 
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ii) Expropriation, requisition, confiscation or nationalization; 

iii) Embargoes, sanctions, rationing of allocation, whether imposed by law, decree or regulation; 

iv) Acts of God, fire, earthquake, storm, lightning, perils of the sea, accidents of navigation, breakdown, 

arrest or restraint of vessels; 

v) Epidemic or quarantine; 

vi) Explosion or breakdown from any cause whatsoever or accidents by force or otherwise to railways, 

storage facilities, processing plants, terminal and loading facilities. 

 

In the event either you or us, are affected by a Force Majeure event, the affected party shall forthwith give 

written notice stating the circumstances of the Force Majeure event thereof to the unaffected party, together 

with an estimate in good faith of the degree to which and the period for which its performance will be affected 

thereby. The affected party shall however go on sending such notice every week so long the event of Force 

Majeure continues. The affected party shall immediately after cessation of the event of Force Majeure undertake 

the obligation arising out of this Purchase Order. In the event of Force Majeure, the party or parties affected 

shall use its or their best efforts to resolve the said Force Majeure event as rapidly as is reasonable and 

practicable. 

 

In the event that we, as a result of Force Majeure, are unable to meet the commitments to your holding contracts 

entitling you to deliver Coal, we shall use our best endeavors to revise deliveries of coal from you in a fair and 

reasonable manner. 

 

M) TRANSACTION FEES 

 

A transaction fee of Rs 10 per tonne (Plus GST)of the bid quantity will be deducted as Transcation fee  from 

successful bidder. 

 

MSTC shall deduct the transaction fee from the successful bidder from the Pre-Bid EMD submitted by them. 

Transaction fee will be calculated on the bid quantity allotted,GST or any other Govt. levies / taxes / charges 

chargeable on the Transaction fee of MSTC will be payable by the successful bidder over and above the 

transaction fee.  This transaction fee along with applicable GST shall be non refundable. 

 

N) SIGNATURE OF THE BID: 

The bid documents uploaded must contain the name, designation and the places of business of the person or 

persons making the bid and must be signed and affixed with seal by the bidder with his usual signature. The 

names of all persons signing should also be typed or printed below the signature. 

  

Each and every page of the Bid documents should be serially numbered and properly signed.Signed document 

should also be uploaded in the website. 

  

Bids by Corporation/company must be signed with the legal name of the Corporation/company by the President, 
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Managing Director or by the Secretary or other person or persons authorized to sign on behalf of such 

Corporation/Company. Satisfactory evidence of authority of the person signing on behalf of the Bidder shall 

invariably be furnished with the bids. 

 

The Power of Attorney (PoA) should be executed to authorize the person signing, preparing, submitting the 

bids/ documents both electronically and physically (of the uploaded documents) and for execution of the 

contract. The Power of Attorney should be authenticated by executing before a Notary public or a Oath 

Commissioner, if executed within India or before the Indian Consulate, if executed Overseas. The PoA requires 

to be stamped as per the Indian Stamp Act and Tamil Nadu State Amendments thereto. 

 

O) ISSUANCE OF LOI (LETTER OF INTENT)/ PURCHASE ORDER:DIL will examine the Lowest bid obtained 

in the e-tender and reverse auction and issue LOI(Letter of intent ) towards acceptance of bid. Bidder should 

sign the document as a token of acceptance and submit it within 1 day from the date of issue of LOI.  After 

receipt of acceptance, formal Purchase order shall be issued by DIL. 

************************ 
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Price bid format –E-Tender 

 
A. FOR EX-PORT RAKE LOADED BASIS 

  

Port Name 

Basic Price ex-port rake loaded basis 
(Rs/MT) 

 Exclusive of GST(5%),Compensation 
cess (Rs 400 per MT) and Railway 

freight with GST  
(A) 

Total landed Price ex-port rake loaded 
basis (Rs/MT) 

 Inclusive  of GST(5%),Compensation 
cess (Rs 400 per MT) except  Railway 

freight with GST  
(B) 

Kakinada    

Krishnapatna
m    

Any Western 
Port (to 
NAME) 

  
 

      

(B) Bidder should quote    Total Landed 
Price  as follows =Basic rate(A)  + GST 
(5%)+GST COMPENSATION CESS (RS 
400/mt)  
Except Railway Freight with GST 
 

 
  
  

B. FOR-PLANT DELIVERED BASIS  

Port 

Basic Price inclusive of Freight 
(Rs/MT) 

(A) 
Exclusive of GST(5%) and 

Compensation cess   

Total Landed Price inclusive of all 
charges   (Rs/MT) 

(B) 
i.e  GST(5%) Compensation cess ( Rs 
400/-) and Railway freight with GST   

Kakinada    

Krishnapatnam    

Any Western Port 
(to NAME)    

      

Bidder should give rates  where  total cost will be 
calculated  as follows  
Total Price (B) = Basic rate(A )+ GST (5%)+GST 
COMPENSATION CESS (RS 400/mt 

 
 

 
 
 
 
 
 
 
 

 
 

PRICE TO BE QUOTED ONLINE and Not to be filled here. 
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C. REVERSE AUCTION :Landed Price per MT,inclusive of GST& CESS . 
 
Reverse Auction shall be conducted  for the landed cost for Per MT as delivered to  Power Station (all inclusive 

such as GST,CESS,FREIGHT etc) and GAR calculated on proportionate basis at 4200 GAR. Bidders offering 

on Ex.Port Rake Loaded basis should also  include Railway freight charges as mentioned on Sl.no 4 depending 

on the port  while submitting their bids in  reverse auction for sake of online comparison with For Plant delivered 

basis . Please note that for Ex.port rake basis , Railway freight charges  will be paid by DIL 

 

 
_____________________________________________________________________ 
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SCHEDULE – A 

MLS/SRO/Operations/17/22-23/ET/29 
 

PROCESS COMPLIANCE STATEMENT (on Company’s letterhead) 
 

Bid Event to be DILd for Procurement of Steaming (Non Coking) Coal in Bulk (Imported) 
DIL  TENDER 

Name of the Organization: 
___________________________________________________ 

 
The following terms and conditions are deemed as accepted by us for participation inthe above bid 

event. We have accepted the auction rules on participation at the bidevent. The award decision by DIL 

would be final and binding on us. 

 

1. We will not divulge either our bids or those of other bidders to any other externalparty. 

2. We agree to non-disclosure of trade information regarding the purchase, identity ofMSTC’s portal, 

bid process, bid technology, bid documentation and bid details. 

3.We agree that all times mentioned for the e – tender and e- reverse auction eventsare as per MSTC 

Server time based on IST. 

4. Inability to bid due to telephone line glitch, Internet response issues, software orhardware hangs will 

not be the responsibility of DIL/MSTC. 

5. Based on the competitive quotes received, DIL's decision will be final andbinding on us. 

6. Our participation in a bid event is by invitation from DIL 

7. DIL is not obliged to place the contract if the expected price of the lots or event is not met. DIL will 

be at liberty to cancel the bid event and initiate afresh one, if necessary. 

8. Bids once finally submitted cannot be withdrawn or modified under any circumstances. 

9. DIL can decide to extend, reschedule or cancel the e-bidding/E-auction. 

10. Bids cannot be increased. Subsequent bids from the same supplier need to be lowerby at least the 

minimum bid decrement from the lowest bid in reverse E-Auction. 

11. We shall indemnify and hold DIL /MSTC, its and their successors and assigns, officers, employees 

and agents harmless from any direct or indirect loss or damage and or claims for personal injury or 

property damage caused by any contractual problems or by our negligent or fraudulent act, omission 

or wilful misconduct or breach of any term of this Agreement. 

12. DIL /MSTC or its employees or other representatives will not be liable for damages arising out of 

or in connection with the use of this site. This is a comprehensive limitation of liability that applies to 

all damages of any kind, including(without limitation) compensatory, direct, indirect or consequential 

damages and claimsof third parties. 

13. DIL/ MSTC will not be liable and responsible in any manner whatsoever for failure to access & bid 

on the e-auction platform due to loss of internet connectivity,electricity failure, virus attack, problems 

with the PC, any other unforeseen circumstances etc. before or during the e-bidding and auction event. 

14. Validity: The bidders should keep their bids valid for a period of 7  DAYS from thedate of the 

opening of techno-commercial bid. No bidder is permitted to withdraw hisquoted rate within the validity 
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period. In case of withdrawal of offer, the EMD will beforfeited and DIL may claim additional expenses, 

if any incurred, from thebidder due to withdrawal of offer by him. 

 

We agree to have read, understood, agreed in toto and to abide by this statement. 

 

Organization 

Name 

Designation 

Signature & stamp /seal 

Date & Place 
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SCHEDULE-B  

MLS/SRO/Operations/17/22-23/ET/29 
 CERTIFICATE REGARDINGACCEPTANCE OFNODEVIATIONS 

(On the letter head of the Bidder) 
 

Ref. No.. ………………………….Date: …………….. 
 
 
To 
MSTC LIMITED 
CHENNAI 

 
Sub: e-Tender NO 

MLS/SRO/Operations/17/22-23/ET/29 
 
 
 

Dear Sir, 
 

1.0 With reference to our Bid for Lot 1 for the subject tender specificationas above, we hereby 

confirm that we comply with all terms ,conditionsand specifications of the Bidding Documents read in 

conjunction withAmendments(s) /Clarification(s) /Addendum / Errata / Corrigendum (ifany) issued by 

the Tender Inviting Authority prior to opening of Techno  Commercial Bids and the same has been 

taken into consideration while making our Techno-Commercial Bid & Price Bid and we declare that 

wehave not taken any deviation in this regard. 

 
2.0 We further confirm that any deviation, variation or additional condition etc. or any mention, 

contrary to Bidding Documents and its Amendments(s)/Clarification(s)/Addendum/Errata/ Corrigendum 

(if any)as mentioned at 1.0above found anywhere in our Techno-Commercial Bid and / or Price Bid, 

implicit or explicit shall stand unconditionally withdrawn, without any cost implication whatsoever to 

Tender Inviting Authority, failing which the EMD shall be forfeited. 

 

 
Place: 

Date: 

 

Signature …………………….. 

 

Name ……………….. 

Designation ………………… 

 Seal ………………………….. 
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SCHEDULE - C 
QUALITY PARAMETERS, SOURCE INFORMATION & PRICE OFFER 

 
E-TENDER REFERENCE: MLS/SRO/OPERATIONS/17/22-23/ET/29 

 
IMPORTANT:1. ALL INFORMATION MUST BE FILLED UP/PROVIDED 

  2.BID SERIAL NUMBER TO BE FILLED IN CASE OF MULTIPLE OFFERS 

 
 
BIDDER INFORMATION: 

BIDDER’S 
NAME: 

 
 

 
SOURCE DATA: (MULTIPLE/OPTIONAL MINES ACCEPTABLE FOR SAME GRADE) 

COUNTRY OF 
ORIGIN: 

 
 

NAME OF MINE/S: 
(MAXIMUM 3) 

1.  

2.  

3.  

LOADING PORT/S: 1.  

2.  

3.  

DISCHARGE 
PORT: 

1.  

2.  

3.  

 
SPECIFICATION: (ASTM BASIS) 

GCV (ARB) KCAL/KG 
GUARANTEED  

SULPHUR (ADB) % 
GUARANTEED  

TOTAL MOISTURE (ARB) % 
GUARANTEED  VM (MIN – MAX) 

ADB %  

INHERENT MOISTURE (ADB)%  HGI  
ASH FUSION (INITIAL 
DEFORM.) (DEG C)  ASH(ADB) % 

GUARANTEED  

  SIZE: MAX % -          
< 2.36MM  
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A. FOR EX-PORT RAKE LOADED BASIS  

Port Name Quantity 
(MT) 

From Kakinada   

From Krishanapatnam   
From Western Port 

NAME:    

 
 
 
B. FOR-PLANT DELIVERED BASIS 

 

Port Quantity (MT) 

From Kakinada   

From Krishanapatnam   
From Western Port 

NAME:    

 
 SAMPLE COA (PROXIMATE, ULTIMATE AND SIEVE ANALYSIS) TO BE ATTACHED 

 

 

 

Name 

Designation 

Signature & stamp /seal 

Date & Place 
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SCHEDULE D  
 

E-TENDER REFERENCE: MLS/SRO/OPERATIONS/17/22-23/ET/29 
Specification of Coal (ASTM basis) (Specification should be same as mentioned in 
Schedule –C ) 
 

GCV (ARB)KCAL/KG __________________ 
 
 

A. FOR EX-PORT RAKE LOADED BASIS 

Port Name Quantity 
(MT) 

Basic Price ex-port rake loaded basis 
(Rs/MT) 

For Actual GCV (ARB) as mentioned in 
Schedule -C  

Basic Price ex-port rake 
loaded basis (Rs/MT) 

Normalized to 4200 GCV 
(ARB) 

Exclusive of 
GST,Compensation cess & 

Railway freight 
From Kakinada       

From Krishanapatnam       
From Western 

Port 
NAME:  

      

 
 

B. FOR PLANT DELIVERED BASIS  

Port Quantity 
(MT) 

Basic Price inclusive of Freight (Rs/MT) 
For Actual GCV (ARB) as mentioned in 

Schedule -C  

Basic Price ex-port rake 
loaded basis (Rs/MT) 

Normalized to 4200 GCV 
(ARB) 

Exclusive of GST & 
Compensation cess 

       

       
       

 
 

 
Name 

Designation 

Signature & stamp /seal 

Date & Place 

 

 


		2023-03-15T19:26:16+0530
	JANAKI RAMAN DAMODARAN




